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8 Chapter 1: Introducing IDL
Overview of IDL

IDL (the Interactive Data Language) is a complete computing environment for the 
interactive analysis and visualization of data. IDL integrates a powerful, array-
oriented language with numerous mathematical analysis and graphical display 
techniques. Programming in IDL is a time-saving alternative to programming in 
FORTRAN or C. Using IDL, tasks which require days or weeks of programming 
with traditional languages can be accomplished in hours. You can explore data 
interactively using IDL commands and then create complete applications by writing 
IDL programs.

Analysis advantages include:

• Many numerical and statistical analysis routines—including Numerical 
Recipes routines—are provided for analysis and simulation of data. 
Compilation and execution of IDL commands provides instant feedback and 
hands-on interaction.

• Operators and functions work on entire arrays (without using loops), 
simplifying interactive analysis and reducing programming time.

• IDL’s flexible input/output facilities allow you to read any type of custom data 
format. See “Supported File Formats” on page 10 for details.

Visualization advantages include:

• Rapid 2D plotting, multi-dimensional plotting, volume visualization, image 
display, and animation allow immediate observation of your computation’s 
results.

• Support for OpenGL-based hardware accelerated graphics.

Application development advantages include:

• IDL is a complete, structured language that can be used interactively and to 
create sophisticated functions, procedures, and applications.

• IDL’s Intelligent Tools (iTools) can be customized with your own operations 
or data manipulations. 

• IDL widgets can be used to quickly create multi-platform graphical user 
interfaces to your IDL programs.

• Existing FORTRAN and C routines can be dynamically-linked into IDL to add 
specialized functionality. Alternatively, C and FORTRAN programs can call 
IDL routines as a subroutine library or display engine.
Overview of IDL Using IDL
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• IDL programs run across all supported platforms (UNIX, Macintosh, and 
Microsoft Windows) with little or no modification. This application portability 
allows you to easily support a variety of computers.
Using IDL Overview of IDL
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Supported File Formats

IDL supports accessing the following types of file formats. 

Image File Formats

For specific routine and object information used in IDL to access these type of files, 
see the “Image Data Formats” category under “Input/Output” (IDL Quick Reference). 

Format Description

BMP Windows Bitmap format

DICOM Digital Imaging and Communications in Medicine

GeoTIFF TIFF file with tags containing geographic data

GIF Graphics Interchange Format 

Interfile Interfile version 3.3 format

JPEG Joint Photographic Experts Group format

JPEG 2000 JPEG 2000 format

Motion JPEG2000 Motion JPEG2000 format

MPEG Moving Picture Experts Group format

MrSID Multi-resolution Seamless Image Database format

NRIF NCAR Raster Interchange Format

PICT Macintosh version 2 PICT files (bitmap only)

PNG Portable Network Graphics format

PPM PPM/PGM format

SRF Sun Raster File format

TIFF 8-bit or 24-bit Tagged Image File format

X11 Bitmap X11 Bitmap format used for reading bitmaps for 
IDL widget button labels

XWD X Windows Dump format

Table 1-1: IDL-Supported Graphics Standards
Supported File Formats Using IDL
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Scientific Data Formats

IDL supports the HDF (Hierarchical Data Format), HDF-EOS (Hierarchical Data 
Format-Earth Observing System), CDF (Common Data Format), and NetCDF 
(Network Common Data Format) self-describing, scientific data formats. Collections 
of built-in routines provide an interface between IDL and these formats. For specific 
routine and object information used in IDL to access these type of files, see the 
“Scientific Data Formats” category under “Input/Output” (IDL Quick Reference). 

Other Data Formats

For specific routine and object information used in IDL to access these data types, see 
the “Other Data Formats” category under “Input/Output” (IDL Quick Reference). 

Format Description

CDF Common Data Format version 3.2

HDF Hierarchical Data Format version 4.2r3

HDF5 Hierarchical Data Format version 5-1.6.7

HDF-EOS Hierarchical Data Format-Earth Observing System 
version 2.8

NCDF Network Common Data Format version 3.5

Table 1-2: IDL-Supported Scientific Data Formats

Format Description

ASCII American Standard Code for Information 
Interchange

Binary Digital data encoded as a sequence of bits 

DXF Drawing eXchange Format

ESRI Shapefile Stores non-topological geometry and attribute 
information

SYLK Symbolic Link Format

VRML Virtual Reality Modeling Language

Table 1-3: Other IDL-Supported File Formats
Using IDL Supported File Formats
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WAV Microsoft Waveform Format

WAVE Wavefront Advanced Data Visualizer Format

XDR eXternal Data Representation

XML eXtensible Markup Language

Format Description

Table 1-3: Other IDL-Supported File Formats (Continued)
Supported File Formats Using IDL
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Launching IDL

You can run IDL either in command-line or graphical mode. In command-line mode, 
IDL uses a text-only interface and sends output to your terminal screen or shell 
window. Graphics are displayed in IDL graphics windows. In graphical mode, IDL 
displays the IDL Workbench, which is an Eclipse-based graphical user interface.

IDL is available in both 32- and 64-bit versions. You can execute the 64-bit version 
only if your system supports 64-bit operations, but you can run the 32-bit version on 
a 64-bit system. On 64-bit systems, you can explicitly specify the 32-bit version by 
adding the -32 flag or selecting a 32-bit IDL icon when launching IDL. See 
Command Line Options for IDL Startup for details.

To launch the IDL program, do one of the following:

Windows Systems

• To start IDL in command-line mode, select IDL Command Line from the 
Start menu, double-click the idl.exe icon in the appropriate IDL installation 
bin directory, or enter idl at the Windows command prompt.

• To start IDL in graphical mode, select IDL Workbench from the Start menu 
or double-click the idlde.exe icon in the installation IDLDE directory.

Macintosh Systems

• To start IDL in command-line mode, click on the idl icon in your IDL 
installation folder or enter idl at the X11 Terminal window shell prompt.

• To start IDL in graphical mode, double-click on the IDL Workbench icon in 
your IDL installation folder or enter idlde at the X11 Terminal window shell 
prompt.

Note
To launch IDL from the shell prompt, you must first explicitly open an X11 
terminal window and set up each IDL user’s environment. See “Defining 
Environment Variables and Aliases” (Installation and Licensing Guide).

Solaris and Linux Systems

• To start IDL in command-line mode, enter idl at the shell prompt.

• To start IDL in graphical mode, enter idlde at the shell prompt.
Using IDL Launching IDL



14 Chapter 1: Introducing IDL
Note
To launch IDL from the shell prompt, you must first explicitly open an X11 
terminal window and set up each IDL user’s environment. See “Defining 
Environment Variables and Aliases” (Installation and Licensing Guide).

Startup Options

You can add options to the command that starts IDL. If you are starting IDL from the 
command or shell prompt, append the option flag after the idl or idlde command. 
(If you are starting IDL on a Windows platform by clicking an icon, modify the 
Target field of the properties dialog for the IDL icon to include the option flag.)

See “Command Line Options for IDL Startup” on page 23 for a listing of the 
available startup options.

What Happens When IDL Starts

When IDL starts up, the following things happen:

• IDL determines the value of the !PATH system variable.

• IDL executes the Startup File, if one is specified.

• If you are using the IDL Workbench, IDL scans all of the .pro code in !PATH 
and in any open projects. (You will notice the words “Analyzing Code” in the 
status area of the IDL Workbench while this is happening.) This analysis 
allows the IDL Workbench to provide Hover Help, Content Assist, and 
chromacoding for your .pro code. Note that you can begin working with IDL 
before the analysis is complete.

Troubleshooting

When IDL is ready to accept a command, it displays the IDL> prompt. If IDL does 
not start, take the following action depending upon the operating system you are 
running:

• Windows: When starting IDL by clicking an icon, be sure that the path listed in 
the Properties dialog for the IDL icon accurately reflects the location of the 
IDL executable file.

When starting IDL from the command prompt, be sure that the intended 
executable file is in the DOS path, or that you are in the proper bin directory.
Launching IDL Using IDL
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• UNIX: Be sure that your PATH environment variable includes the directory 
that contains IDL. See “Defining Environment Variables and Aliases” 
(Installation and Licensing Guide).
Using IDL Launching IDL
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Launching the iTools

The IDL Intelligent Tools (iTools) are a set of interactive utilities that combine data 
analysis and visualization with the task of producing presentation quality graphics. 
Based on the IDL Object Graphics system, the iTools are designed to help you get the 
most out of your data with minimal effort. They allow you to continue to benefit from 
the control of a programming language, while enjoying the convenience of a point-
and-click environment. Each tool is designed around a specific visualization type:

• Two and three dimensional plots (line, scatter, polar, and histogram style)

• Surface representations

• Contour maps

• Image displays

• Volume visualizations

• Maps

• Vector displays

Figure 1-1: Black Hole Density Data in the iVolume Tool
Launching the iTools Using IDL



Chapter 1: Introducing IDL 17
For detailed information on the new iTools and how to use them, see the iTool User’s 
Guide.

The iTools are built upon an object-oriented framework, or set of object classes, that 
serve as the building blocks for their interface and functionality. IDL programmers 
can easily use this framework to create custom data analysis and visualization 
environments. Such custom Intelligent Tools may be called from within a larger IDL 
application, or they may serve as the foundation for a complete application in 
themselves. For more information on creating your own custom iTools, see the iTool 
Programming.

Starting an iTool

To get started using the new IDL iTools, from the IDL Workbench command line, 
simply type the name of the tool you wish to call. The tools available are:

• iContour

• iImage

• iMap

• iPlot

• iSurface

• iVector

• iVolume

Loading Data into an iTool

There are multiple options for loading your data into your chosen iTool for 
visualization:

• Command Line Argument — At the IDL Command Line enter: 
mydata = RANDOMU(SEED, 45)
iPlot, mydata 

This option allows you to have control over parameters and keyword options 
for setting up the way you wish your plot (or other visualization) to appear.

• Workbench: File → Open — If you are using the IDL Workbench, selecting 
Open from the Workbench File menu and selecting an image format file will 
automatically open an IIMAGE tool containing the selected image.

• Workbench: Drag to Tool Palette — If you are using the IDL Workbench 
Visualize perspective, you can simply drag one or more variables from the 
Using IDL Launching the iTools
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Variables view to a tool in the Tool Palette view. IDL will create an iTool 
visualization that matches the number of parameters you dragged.

• Workbench: Drag to Tool Action — If you are using the IDL Workbench 
Visualize perspective, you can drag one or more variables from the Variables 
view to a specific action in the Tool Palette. This method allows you greater 
control over the visualization created.

• iTool: File → Open — If you have an iTool open, this is the quickest way to 
create a default visualization of your data.

• iTool: File → Import → IDL variable — This will invoke the IDL Import 
wizard.

• iTool: File → Import → From a File -— This also invokes the IDL Import 
wizard.

• iTool: Insert → Visualization — This method gives you parameter control 
similar to using the command line.

Note
For more detailed information on loading data into the iTools, see Chapter 2, 
“Importing and Exporting Data” (iTool User’s Guide).

The iTools Data Manager

All data used by any iTool is first loaded into the iTools Data Manager, which keeps 
track of which data items are associated with an iTool visualization. The Data 
Manager provides a convenient and structured environment in which to import and 
view files and variables.

The process of loading data into the Data Manager is entirely automatic if you 
specify data when launching an iTool at the IDL command line, by dragging from the 
IDL Workbench Variables view to a Workbench action, or if you open a data file 
using the Open command from the iTool’s File menu. In these cases, the iTool will 
import the data in the specified file or variable and create a visualization of the default 
type for the selected data and the iTool you are using.

If you want more control over the process of creating a visualization, you can load 
data into the Data Manager manually, either from a data file or from one or more 
variables that exist in your current IDL session. Once a data item is placed in the Data 
Manager, it is available to all iTools until it is removed.
Launching the iTools Using IDL
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Environment Variables Used by IDL

When IDL starts, it checks for the presence of a number of environment variables. If 
one of these environment variables exists, its value is used in one of two ways:

• As the value for a preference

• To configure IDL’s environment in such a way that it can load and run

Preferences

Preferences are internal values that control various aspects of the environment IDL 
presents to its users. While user preference values are most often retrieved from 
preference files, the value of any preference can be defined by setting an environment 
variable of the same name to the appropriate value. For example, to set the value of 
the IDL_PATH preference, which supplies the initial value of the !PATH system 
variable, you would define an environment variable named IDL_PATH. 

If an environment variable corresponding to a preference exists, its value will be used 
as the value of that preference unless the value is explicitly overridden with a value 
set at the command line when invoking IDL. See Appendix E, “IDL System 
Preferences” (IDL Reference Guide) for a detailed description of IDL’s preferences 
system and the precedence given to different sources for preference values.

Non-Preference Environment Variables

IDL checks the following environment variables at startup, but does not use the 
values as the values of IDL preferences.

CLASSPATH

The Java Connectivity bridges use the value of the CLASSPATH environment 
variable to locate IDL-supplied and user-defined Java classes.

DISPLAY

On UNIX platforms, IDL uses the DISPLAY environment variable to choose which 
X display is used to display graphics. 

HOME

IDL uses the value of the HOME environment variable when storing user-specific 
information in the local file system.
Using IDL Environment Variables Used by IDL
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Note
Under Microsoft Windows, the HOME environment variable might not be set in all 
cases. If it is not set, IDL first attempts to substitute the USERPROFILE 
environment variable (which usually looks something like C:\Documents and 
Settings\username where username is the login name of the current user). If 
USERPROFILE is not set, IDL uses the value of the first of the following it finds: 
the TEMP environment variable, the TMP environment variable, or the Windows 
system directory.

IDL_BRIDGE_DEBUG

The IDL export bridges check the value of the IDL_BRIDGE_DEBUG environment 
variable to enable or disable debugging support. Setting this environment variable to 
an appropriate value causes the Connectivity bridge to send debugging information 
that would typically appear in the IDL Output log to stdout. In addition, on 
Windows systems, debugging information is also written with the 
OutputDebugString() API, whose output can be captured by the Debug Monitor 
(DBMON.exe) tool (provided in the Platform SDK), Visual Studio, or the WinDbg 
debugger.

When IDL_BRIDGE_DEBUG is enabled, the following debug information is 
available:

• Library load errors (on Windows)

• IDL execution errors

• Output from the IDL print command

This table below shows the valid values for the IDL_BRIDGE_DEBUG environment 
variable and their meanings:

All other values will be ignored. See either “Debugging COM Wrapper Objects” in 
Chapter 8 or “Debugging Java Wrapper Objects” in Chapter 9 in the IDL 
Connectivity Bridges manual for more information. 

Value Behavior

0 Turn off debug output

1 Turn on debug output
Environment Variables Used by IDL Using IDL
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IDLJAVAB_CONFIG

The IDL-Java bridge uses the value of the IDLJAVAB_CONFIG environment 
variable to locate the IDL-Java bridge configuration file. See “Initializing the IDL-
Java Bridge” (Chapter 5, IDL Connectivity Bridges) for additional details.

IDLJAVAB_LIB_LOCATION

The IDL-Java bridge uses the value of the IDLJAVAB_LIB_LOCATION 
environment variable to determine which JVM shared library within a given Java 
version to use. See “Initializing the IDL-Java Bridge” (Chapter 5, IDL Connectivity 
Bridges) for additional details.

LD_LIBRARY_PATH

On UNIX systems, the Java Connectivity bridges use the value of the 
LD_LIBRARY_PATH environment variable to determine where IDL’s shared 
library files are located.

LM_LICENSE_FILE

IDL’s FLEXlm-based license manager uses the value of the LM_LICENSE_FILE 
environment variable to determine where to search for valid license files. Consult the 
license manager documentation for details.

PATH

When IDL asks for an operating system resource such as a shell, the executable file 
for that resource must be located in the operating system’s path. While IDL itself 
does not use the value of the PATH environment variable explicitly, its value does 
affect IDL’s behavior when attempting to launch other applications.

TERM

On UNIX platforms, IDL uses the environment variable TERM to determine the type 
of terminal in use when IDL is in command-line mode.

Setting Environment Variables

The process used to set environment variables varies depending on the operating 
system you are using.
Using IDL Environment Variables Used by IDL
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UNIX and MacOS X Systems

On UNIX systems, environment variables are generally specified in a file read by 
your shell program at startup. Syntax for setting environment variables varies 
depending on the shell you are using, as does the file you use to specify the variables. 
If you are unsure how to set environment variables on your system, consult the 
system documentation or a system administrator.

For example, to set the environment variable IDL_PATH to the value 
/usr/local/idl when using a C shell (csh), you would add the following line to 
your .cshrc file:

setenv LM_LICENSE_FILE /usr/local/idl/license/license.dat

Similarly, to set the same variable when using a Bourne shell (sh), you would add the 
following lines to your .profile file:

LM_LICENSE_FILE="/usr/local/idl/license/license.dat" \
; export LM_LICENSE_FILE

Microsoft Windows Systems

On Microsoft Windows systems, environment variables are set in the Environment 
Variables dialog, which is accessible from the System Control panel. Some Windows 
versions allow you to set environment variables either only for the user you logged in 
as (“user variables”) or for all users (“system variables”). Setting IDL environment 
variables as user variables means that other users who log on to the computer will not 
have access to your environment variable values.
Environment Variables Used by IDL Using IDL



Chapter 1: Introducing IDL 23
Command Line Options for IDL Startup

You can alter some IDL behaviors by supplying command-line switches along with 
the command used to invoke IDL. The following table shows the IDL command-line 
switches and the IDL interfaces to which they apply:

Switch
IDL 

Workbench
(idlde)

Command Line
(idl)

Windows
Virtual 

Machine
(idlrt)UNIX Windows

-32 • • •

-arg • • • •

-args • • • •

-batch •

-data •

-demo • • • •

-e • • •

-em • •

-minimized •

-nl •

-novm • •

-pref • • • •

-queue • • • •

-quiet • • • •

-rt • 

-ulicense • • • •

-vm • •

Table 1-4: Command Line Switches
Using IDL Command Line Options for IDL Startup
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Preference Switches

In addition to the switches listed above, you can specify the value of IDL preferences 
when invoking IDL. See “Specifying Preferences at the Command Line” on page 29 
for details.

Opening a File from the Command Line

The IDL Workbench will automatically open a file in an editor if you provide the file 
name as an argument. The syntax is:

idlde ["]file_to_open["]

Although quotation marks are optional, they ensure an unambiguous result on all 
Windows platforms.

Batch Mode

IDL can also be started in non-interactive batch mode by specifying the name of a 
batch file at startup time.

The syntax for running the IDL Workbench (idlde) and command-line IDL (idl) in 
batch mode is:

idl batch_file

or
idlde -batch batch_file

Note
When starting IDL in batch mode, batch_file should be located on the IDL path, or 
it should be a fully-qualified pathname.

Command-Line Switches

The following command line switches can be used when invoking IDL. Unless 
otherwise noted, switches can be combined and specified in any order.

-32

Syntax: -32

Starts IDL in 32-bit mode. If this switch is not set, IDL starts in 64-bit mode by 
default for those platforms that support 64-bit. If you have not installed the 64-bit 
version, the 32-bit version will automatically be started. If you have not installed the 
32-bit version, this flag will not work.
Command Line Options for IDL Startup Using IDL
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-arg

Syntax: -arg value

Specifies a single command line option to be passed for subsequent access via the 
COMMAND_LINE_ARGS function. The value is saved as a string. Multiple -arg 
switches are allowed; the values are saved in the order specified. The -arg option 
can be used to pass program-specific information from the command line to IDL 
programs.

-args

Syntax: -args value1 value2 ... valueN

Specifies one or more command line options to be passed for subsequent access via 
the COMMAND_LINE_ARGS function. When IDL sees the -args option, it takes 
any command-line arguments that follow it and passes them all as a string array. 
There can only be one -args option on an IDL command line, and it is always the 
final option. The -args switch can be used with the -arg switch; if both switches 
are specified, occurrences of -arg must come first, and the values specified by -args 
are saved following any values specified by -arg.

-batch

Syntax: -batch

Specifies a file to be executed in non-interactive “batch” mode.

-demo

Syntax: -demo

Forces IDL to run in seven-minute demo mode.

-e

Syntax: -e IDL_statement

Specifies a single IDL statement to be executed. Once the statement has executed, 
IDL waits for any widget applications to exit, and then IDL itself exits. Only the last 
-e switch on the command line is honored.

Note
If the IDL statement includes spaces, it must be enclosed in quote marks. Under 
UNIX the statement can be enclosed in either single or double quotes, but under 
Microsoft Windows the statement must be enclosed in double quotes.
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Under UNIX, the -e switch always uses the command line interface (that is, the 
idlde command followed by the -e switch behaves like the idl command followed 
by the -e switch).

Under Microsoft Windows, the idlde command displays the full IDL Workbench, 
but the user is not prompted for IDL commands to execute. This mode is primarily 
useful because the output log window is visible, and will show any output generated 
by the IDL statement.

Note
Because the -e switch causes IDL to exit as soon as the statement is complete, if 
the IDL statement being executed produces graphics, you may wish to delay the 
exit until the user has a chance to view the graphics. In such a case, you must 
explicitly cause IDL to wait before exiting. For example, the following will produce 
a plot of one cycle of a sinusoid:

idlde -e "PLOT, SIN(FINDGEN(628)/100) & t=DIALOG_MESSAGE('Done')"

The plot will remain on the screen until the user dismisses the dialog, at which point 
IDL will exit.

-em

Syntax: -em=file

Starts IDL with an embedded license. The file argument should be an IDL .sav file 
that contains an embedded (“unlimited right to distribute”) IDL license. See Chapter 
23, “Distributing Runtime Mode Applications” (Application Programming) for 
details on creating applications with an embedded IDL license.

-minimized

Syntax: -minimized

Forces the IDL Workbench to start minimized.

-novm

Syntax: -novm

Forces IDL to run in seven-minute demo mode rather than Virtual Machine mode if 
no license is available. This switch can only be used in conjunction with the -rt 
switch or the idlrt.exe executable. 
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If IDL attempts to load and run an IDL application in runtime mode, but finds no 
license available, its default behavior is to load the application in Virtual Machine 
mode. Setting the -novm switch prevents the application from running in Virtual 
Machine mode, and instead causes it to run in demo mode.

This switch has no effect on the UNIX or Windows IDL Workbench.

-pref

Syntax: -pref=file

Loads the specified preference file. The file argument should be a text file containing 
IDL preference/value pairs. See Appendix E, “IDL System Preferences” (IDL 
Reference Guide) for a detailed description of IDL’s preferences system, the format 
of preference files, and the precedence given to different sources for preference 
values.

Note
If a relative path specification is provided for file, the path is relative to the 
directory from which IDL is started.

This feature is of particular interest to those writing stand-alone applications in IDL, 
possibly using the runtime or Virtual Machine modes of operation. The use of a 
command-line preference file allows authors of such applications to control the 
values of preferences important to their applications in a way that is user-adjustable 
and not hard-coded in their application.

-queue

Syntax: -queue

Causes IDL to wait for a license to become available before beginning an IDL task 
such as batch processing. This switch is useful for users of counted floating licenses 
who need their IDL process to run in licensed mode rather than in seven-minute 
demo mode.

-quiet

Syntax: -quiet

Suppresses printing of the IDL announcement and the motd.txt file. See “Message 
of the Day Files” on page 33 for details on message-of-the-day files.

This switch is supported for Windows idlrt.exe, but it has no effect.
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-rt

Syntax: -rt=file

Starts IDL with a runtime license. If the file argument is specified, it should be an 
IDL .sav file. If the file argument is not specified, IDL attempts to run a file named 
runtime.sav. See Chapter 23, “Distributing Runtime Mode Applications” 
(Application Programming) for details on creating runtime applications.

This switch is accepted by the idlrt.exe application on Microsoft Windows 
platforms, but it is redundant.

-ulicense

Syntax: -ulicense

Checks out a unique license even if IDL is already running on the same host and user 
account. If IDL has checked out a unique license using this flag, the user is allowed to 
change the DISPLAY environment variable after IDL has started.

-vm

Syntax: -vm=file

Starts the IDL Virtual Machine. If the file argument is specified, it should be an IDL 
.sav file. If the file argument is not specified, IDL displays a file selection dialog. 
See Chapter 24, “Distributing Virtual Machine Applications” (Application 
Programming) for details on creating applications that run in the IDL Virtual 
Machine.

Eclipse Command Line Flags

The following flags are native to Eclipse and are accepted by IDL at the command 
line:

-data

Syntax: -data path

Selects a different workspace, located in path.

-nl 

Syntax: -nl locale

Selects a different locale (language). Locale is a two-letter ISO language code, such 
as en (English), es (Spanish), de (German), fr (French), it (Italian), or ja (Japanese).
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Eclipse and the IDL Workbench are both internationalized, but do not share the same 
language list. If a language is chosen that both platforms do not support, there will be 
translation mismatches in the UI (Eclipse portions of the UI will be documented in 
one language, and IDL Workbench portions documented in another).

Specifying Preferences at the Command Line

In addition to the command line switches described above, the value of any IDL 
preference can be specified at the command line using the following syntax:

idlcommand -PREFERENCE value

where idlcommand is the command used to launch IDL (one of idl, idlde, or 
idlrt), PREFERENCE is the name of an IDL preference (note the leading hyphen), 
and value is the value for the preference. For example, to set the value of the 
IDL_MORE preference to one when launching IDL in command-line mode on a 
UNIX machine, you would use the following command line:

idl -IDL_MORE 1

Any number of preference values can be specified at the command line. See 
Appendix E, “IDL System Preferences” (IDL Reference Guide) for a detailed 
description of IDL’s preferences system and the precedence given to different 
sources for preference values.

Using Switches Under Windows

Under Microsoft Windows, applications can be launched either from the prompt in a 
Command Window or by double-clicking on the application icon. If you launch IDL 
from a command prompt, simply specify the switch after the name of the IDL 
executable you are using. For example, to start IDL in Virtual Machine mode using 
the -vm switch, use the following command:

C:\IDL_DIR\bin\bin.platform\idlrt.exe -vm=file.sav

where IDL_DIR is the directory where you have installed IDL, platform is the 
platform-specific bin directory, and file.sav is the name of the SAVE file you 
wish to restore and run.

As another example, use the following command to start the IDL Workbench in quiet 
mode:

C:\IDL_DIR\idlde\idlde.exe -quiet

Again, IDL_DIR is the directory where you have installed IDL.
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If you launch IDL by double-clicking on the application icon, set the switches by 
following this procedure:

1. Right-click the IDL application icon, and select Properties.

The IDL Properties dialog displays.

2. On the Shortcut tab, add the switches after the executable path in the Target 
box.
Command Line Options for IDL Startup Using IDL



Chapter 1: Introducing IDL 31
Startup File

A startup file is a batch file that is executed automatically each time the IDL is 
started. The name of the startup file is specified by the IDL_STARTUP preference. 
You can set the value of this preference manually (see Appendix E, “IDL System 
Preferences” (IDL Reference Guide) for information on IDL’s preferences system) or 
using the “IDL” page of the IDL Workbench Preferences dialog.

Common uses for startup files include the following:

• Restoring variable data contained in a .sav file or reading in commonly used 
data

• Setting common keywords to the DEVICE procedure

• Specifying shared or private color maps for PseudoColor devices

Startup files are executed one statement at a time. It is not possible to define program 
modules (procedures, functions, or main-level programs) in the startup file. For more 
information on creating batch files, see Chapter 3, “Executing Batch Jobs in IDL” 
(Application Programming). 

Understanding When Startup Files are Not Executed

Startup files are executed only when a command line is present. (Prior to IDL 6.2, 
IDL would execute the startup file specified by the environment variable 
IDL_STARTUP even if no IDL command line was present.) Now, however, the 
startup file is not executed when running the following types of applications: 

• IDL Virtual Machine applications

• Runtime applications

• Applications using an IDL Remote Procedure Call server

• Callable IDL applications

• COM and Java Connectivity Bridge applications

• Applications that use the IDL_IDLBridge object

In most cases the new behavior is desirable; you as the developer of an IDL 
application do not necessarily know whether the end user of your application has an 
IDL startup file.
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If, however, you are creating an application that relies on settings defined in a startup 
file, you have the following options: 

• Use the IDL preferences system, rather than a startup file, to set the 
appropriate values. This option is only available if the values being defined in 
the startup file correspond to IDL preferences.

• If your application is not a Virtual Machine or Runtime IDL application, 
explicitly execute the startup file after your IDL session has begun. See the 
following section for details.

Manually Executing a Startup File

To explicitly execute the startup file after an IDL process has been started (either 
through the IDL_IDLBridge object or a Connectivity Bridge wrapper object), 
complete the following steps:

1. Create a string variable containing the “@” character concatenated with the 
name of the startup file:

startup_file = '@' + PREF_GET('IDL_STARTUP')

2. Using the appropriate “execute string” functionality for your application to 
execute the string variable. 
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Message of the Day Files

When IDL starts, it displays the contents of the motd.txt file, located in the 
help/motd subdirectory of the IDL distribution, in the Output Log. You can use this 
Message of the Day file to provide information to IDL users every time IDL starts.

In addition, IDL will display the contents a file with the name platform.txt 
located in the help/motd subdirectory of the IDL distribution, where platform is a 
string corresponding to the current operating system platform. For example, on Linux 
systems, IDL displays a file named linux.txt.

You can determine the correct name for this file on a given platform by using the 
following IDL command:

PRINT, !VERSION.OS

and appending the “.txt” extension to the operating system name.

If you do not want to see either the motd.txt file or the platform-specific file each 
time IDL starts, remove them from the help/motd subdirectory of the IDL 
distribution. 

Note
The motd.txt and platform-specific files are simply an ASCII text files—not IDL 
programs or batch files. To execute a series of IDL commands, select a startup file 
as described in “Startup File” on page 31.
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Using Your Mouse with IDL

IDL supports the use of mice with up to three buttons. Because some systems use 
mice with one or two buttons, IDL provides mechanisms for simulating a three-
button mouse.

Using a Two-Button Mouse

Some mice used with Microsoft Windows systems have only two buttons. See your 
system documentation for information on emulating a middle-button press.

Using a Macintosh (One-Button) Mouse

Some mice used with Macintosh systems have only one button. The X Window 
System software provided with MacOS X provides multi-button mouse emulation, 
allowing you to configure the system to generate middle- and right-button press 
events. See your MacOS X system documentation for details.
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Using Keyboard Accelerators

IDL supports the use of keyboard accelerators or shortcuts in both the IDL 
Workbench and in IDL widget applications. For information on IDL Workbench 
keyboard shortcuts, see Accelerate Code Development in the Editor. Keyboard 
shortcuts can also be defined for individual buttons and menu items in an IDL widget 
application. Defining shortcut key combinations is the responsibility of the IDL 
programmer who creates the widget application; if you are using a widget application 
and are unsure about whether keyboard shortcuts have been defined, contact the 
author of the widget application. For information on adding keyboard accelerators to 
your own widget applications, see “Enhancing Widget Application Usability” 
(Chapter 3, User Interface Programming).

Enabling Alt Key Accelerators on Macintosh

If you are using IDL on a Macintosh and wish to use keyboard accelerators that use 
the Alt key, you will need to perform the following steps to make the Apple 
(Command) key to function as the Alt key:

1. Create a .Xmodmap file in your home folder and add the following three lines 
to it:

clear mod1
clear mod2
add mod1 = Meta_L

When Apple’s X11 program starts, this file will automatically be read, and the 
Apple key will be mapped to the left meta key , which for IDL’s purposes is 
the Alt key. (Windows Alt key accelerators are mapped to the Macintosh 
Apple key, not the Option (alt) key.)

2. Run Apple’s X11 program and change its preferences. Under Input in the X11 
Preferences dialog, make sure that the following two items are unchecked:

• Follow system keyboard layout

• Enable key equivalents under X11

Note
You must relaunch Apple’s X11 program for these changes to take effect. 

Once you have performed these steps, keyboard shortcuts will operate in the normal 
Macintosh fashion — namely, pressing the Apple key in conjunction with X, C, and 
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V will perform cut, copy and paste. The IDL Workbench’s other shortcuts and any 
widget accelerators defined to use the Alt key will also work.
Using Keyboard Accelerators Using IDL



Chapter 1: Introducing IDL 37
Getting Help with IDL

IDL’s online help system provides access to information on all aspects of IDL. The 
complete IDL documentation set is available online in HTML format. To use the IDL 
online help system, do one of the following:

• Enter the ? command (optionally followed by a routine or object name) at the 
IDL command prompt

• Call the ONLINE_HELP procedure at the IDL command prompt or within an 
IDL program

• If you are running the IDL Workbench, select the Help → Help Contents 
option from the menu bar

• Select IDL Help from the Microsoft Windows Start menu

• Double-click on the IDLHelp Macintosh icon

IDL’s online help system is described in detail in Using IDL Help — located, 
appropriately enough, in the IDL online help system.
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Typographical Conventions

The following typographical conventions are used throughout the IDL documentation 
set:

• UPPER CASE type
IDL functions and procedures, and their keywords are displayed in UPPER 
CASE type. For example, the calling sequence for an IDL procedure looks like 
this:
CONTOUR, Z [, X, Y]

• Mixed Case type
IDL object class and method names are displayed in Mixed Case type. For 
example, the calling sequence to create an object and call a method looks like 
this:
object = OBJ_NEW('IDLgrPlot')
object -> GetProperty, ALL=properties

• Italic type
Arguments to IDL procedures and functions — data or variables you must 
provide — are displayed in italic type. In the above example, Z, X, and Y are all 
arguments.

• Square brackets ( [ ] )
Square brackets used in calling sequences indicate that the enclosed arguments 
are optional. Do not type the brackets. In the above CONTOUR example, X 
and Y are optional arguments. Square brackets are also used to specify array 
elements.

• Courier type
In examples or program listings, things that you must enter at the command 
line or in a file are displayed in courier type. Results or data that IDL 
displays on your computer screen are also shown in courier type. An example 
might direct you to enter the following at the IDL command prompt:
array = INDGEN(5)
PRINT, array

In this case, the results are shown like this:
      0       1       2       3       4
Typographical Conventions Using IDL



Chapter 1: Introducing IDL 39
Quitting IDL

To quit IDL, do one of the following:

• Enter the EXIT command at the IDL command prompt.

• If you are running the IDL Workbench, select the Exit option from the File 
menu.

• Under Microsoft Windows, press Alt+F4.

• Under UNIX or MacOS X, if you use IDL’s command-line mode, press 
Ctrl+D as the first character in command-line mode causes IDL to exit back to 
the operating system. The EXIT procedure has the same function. If Ctrl+D is 
not the first character, it simply ends the input line as if a return had been 
entered. 

Note
When using IDL’s command-line mode under UNIX or MacOS X, you can 
normally press Ctrl+Z to suspend IDL and return you to the shell process without 
exiting IDL. After completing any shell commands, type fg to return IDL to the 
foreground. Although the UNIX suspend character can be changed by the user 
outside of IDL, this is rarely done. For the purposes of this manual, we assume the 
default convention. 
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Reporting Problems

We strive to make IDL as reliable and bug free as possible. However, no program 
with the size and complexity of IDL is perfect, and problems do surface. When you 
encounter a problem with IDL, the manner in which you report it has a large bearing 
on how well and quickly we can fix it.

The relnotes.txt file accompanying each release includes information about new 
features in that release, bug fixes, and known problems which may be of help. 

This section is intended to help you report problems in a way which helps us to 
address the problem rapidly.

Background Information

Sometimes, a problem only occurs when running on a certain machine, operating 
system, or graphics device. For these reasons, we need to know the following facts 
when you report a problem:

• Your IDL installation number.

• The version of IDL you are running.

• The type of machine on which it is running.

• The operating system version it is running under.

• The type and version of your windowing system if you are on UNIX.

• The graphics device, if the problem involves graphics and you know what 
graphics device is on your system.

The installation number is assigned by us when you purchase IDL and is included in 
the license information that we sent you. The IDL version, site number, and type of 
machine are printed when IDL is started. 

For example, the following startup announcement appears indicating you are running 
IDL version 7.1 under Sun Solaris using installation number xxxxx-x, under a 
floating license located on a particular license manager.

IDL Version 7.1, Solaris (sunos sparc m64).
(c) 2007, ITT Visual Information Solutions
Installation number: xxxxx-x.
Licensed for use by: ITT Visual Information Solutions IDL floating licenses
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proving that a problem is within IDL and not the dynamically loaded code is entirely 
the programmer's.

Although it is certainly true that a problem in this situation can be within IDL, it is 
very important that you exhaust all other possibilities before reporting the problem. If 
you decide that you need to report the problem, the comments above on simplifying 
things are even more important than usual. If you send us a small example that 
exhibits the problem, we may be able to respond with a correction or advice. 

Contact Us

To report a problem, visit our website at:

http://www.harrisgeospatial.com/contactus.aspx
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Chapter 2

Customizing IDL on 
Motif Systems
This chapter describes techniques for customizing versions of IDL running under the X Window 
System (Motif) graphical user interface.
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X Resources in Brief

The component widgets of an X Window System application each have two names, a 
class name that identifies its type (e.g., XmText for the Motif text widget) and an 
instance name (e.g., width, the name of the property that defines the width of the 
widget on the screen). The class name can be used to set resources for an entire class 
of widgets (e.g., to make all text widgets have a black background) while the instance 
name is used for control of individual widgets or properties.

Applications consist of a tree of widgets, each having a class name and an instance 
name. To specify a resource for a given widget, list the names of the widgets lying 
between the top widget and the target widget from left to right, separated by periods. 
In a moderately complicated widget hierarchy, only some of the widgets are of 
interest; there are intervening widgets that serve uninteresting purposes (such as a 
base that holds other widgets). A star (*) character can be used as a wildcard to skip 
such widgets. Another fact to keep in mind is that a given resource specification is 
interpreted as broadly as possible to apply to any widget matching that description. 
This allows a very small set of resource specifications to affect a large number of 
widgets.
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X Resources and IDL Preferences

Beginning with IDL 6.2, many values used to customize the appearance and behavior 
of IDL on UNIX platforms are stored in IDL preferences rather than in X resources. 
See Appendix E, “IDL System Preferences” (IDL Reference Guide) for a detailed 
description of IDL’s preferences system.

Not all X resources have corresponding preference values. Generally speaking, the 
X resource values that have not been implemented as preferences either control the 
way in which Motif system widgets such as the File Selection dialog are drawn or the 
way in which Motif widgets used by IDL behave (key bindings and scrolling 
behavior, for example). While the system default Idl X resource file contains settings 
for some of these resources, there should be very few occasions when IDL users need 
to modify the values.
Using IDL X Resources and IDL Preferences
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X Resource Files Used by IDL

There are two resource files used to customize the IDL:

• An installation-wide resource file called Idl is located in
<IDL_DIR>/resource/X11/lib/app-defaults

Modifying the global Idl resource file effects an installation-wide 
customization. Changes to the Idl file are not migrated when a new version of 
IDL is installed.

• The .Xdefaults file located in each user’s home directory. Modifying this 
file changes IDL’s behavior for the individual user only.

Note
The $HOME/.idlde file read by previous versions is no longer used by IDL 7.0 and 
later.
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Format of IDL X Resources

IDL resource strings begin with the characters “Idl”. While most of the resources 
that were used by IDL versions earlier than IDL 6.2 have been superseded by 
preferences in the IDL preference system, some X resources are still used. For 
example, the resource

Idl*XmFileSelectionBox.width

is used to define the width of the file selection dialog displayed by the 
DIALOG_PICKFILE function.

To specify a value for an X resource, append a colon character and the value after the 
resource string. Whitespace is ignored. For example:

Idl*fontList:fixed

is the same as
Idl*fontList: fixed
Using IDL Format of IDL X Resources
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Reserving Colors

If you use a PseudoColor display device, when IDL starts, it attempts to secure 
entries in the shared system color map for use when drawing graphics. In versions of 
IDL prior to version 7.0, the value of the Idl.colors X resource was used, either to 
specify the number of colors to be allocated to the shared colormap or to populate the 
value of the IDL_GR_X_COLORS system preference.

In IDL 7.0 and later, IDL simply uses the value of the IDL_GR_X_COLORS system 
preference. If for some reason IDL cannot allocate the requested number of colors 
from the shared colormap, it will create a private colormap. Using a private colormap 
ensures that IDL has the number of colormap entries necessary, but can lead to 
colormap flashing when the cursor or window focus moves between IDL and other 
applications.

One way to avoid creating a private colormap for IDL is to set the 
IDL_GR_X_COLORS preference equal to a negative number. This causes IDL to try 
to use the shared colormap, allocating all but the specified number of colors. For 
example, setting the preference value to -10 instructs IDL to allocate all but 10 of the 
currently available colors for its use. Thus, if there are a total of 220 colors not yet 
reserved by other applications (such as the windowing system), IDL will allocate 210 
colors from the shared colormap.

Note
If you use a TrueColor display device, IDL does not rely on the system’s shared 
color map when drawing graphics. There is no need to either reserve colors from the 
shared color map or create a private color map.
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Importing and Writing 
Data into Variables
This chapter provides an introduction to accessing, reading and writing data using the dialogs, and 
routines found in IDL.
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Overview of Data Access in IDL

There are several ways to open files and access the data that they contain in IDL.You 
can open a file using interface elements, or using routines. In order of increasing 
complexity and flexibility, your options are:

• Accessing files using the IDL Workbench — select Open from the 
Workbench File menu and browse to select a file. For supported file types, IDL 
automatically reads the data and creates variables in IDL’s main scope. If you 
select an image file, the Workbench will also automatically display the image 
in the iImage tool. See Importing Data into the IDL Workbench for details. For 
information on adding supported file types, see Adding Custom File Readers.

• Accessing files using the IOPEN routine — use the IOPEN routine to open a 
specified file and create data variables automatically from the IDL command 
line.

• Accessing data in iTools — select Open from an iTool File menu and browse 
to select a file. This option automatically displays data (that is a supported 
type) in the iTool. See Chapter 2, “Importing and Exporting Data” (iTool 
User’s Guide) for details. 

• Accessing files using dialogs — launch an IDL dialog and browse to select or 
save a file. After accessing the file, use an IDL routine to access the data 
within the file. You can then preform additional data processing task or create 
a display. See “Accessing Files Using IDL Dialogs” on page 53 for details. 

• Accessing files programmatically — you can access data without requiring 
user interaction by using IDL statements in a program or at the command line. 
This give you the greatest control over the state of data at all times, but 
requires slightly more programming than the previous option. See “Accessing 
Files Programmatically” on page 59 for details.

There are advantages and disadvantages for each option. When you open a file using 
File → Open in the iTools, there is no opportunity to do pre-processing on the data. 
However, the display is created for you, and there are numerous interactive 
operations available. 

You can combine the flexibility of accessing data using routines with the power of an 
iTool display by using the Visualize Perspective as described in Using the Visualize 
Perspective or by launching the iTool from the command line as described in 
“Parameter Data and the Command Line” (Chapter 2, iTool User’s Guide). See 
“Accessing Image Data Programmatically” on page 60 and “Accessing Non-Image 
Data Programmatically” on page 64 for examples.
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Accessing Files Using IDL Dialogs

DIALOG_PICKFILE and DIALOG_READ_IMAGE are the two primary file access 
dialogs in IDL. Use DIALOG_PICKFILE to select any type of file. You can select 
multiple files, define the directory or define file filters using keywords. Use 
DIALOG_READ_IMAGE to access supported image formats (listed in “Image File 
Formats” on page 10). This dialog offers preview capabilities and basic image 
information. The corollary DIALOG_WRITE_IMAGE allows you to write data to a 
select image file type. 

See the following topics for more information:

• “Accessing Any File Type Using a Dialog” below

• “Importing an Image File Using a Dialog” on page 54

• “Saving an Image File Using a Dialog” on page 54

You can use other dialogs to access ASCII, binary and HDF data as described in:

• “Reading ASCII Data” on page 55

• “Reading Binary Data” on page 57 

Note
Also see “CW_FILESEL” (IDL Reference Guide) for an example that configures a 
compound widget to open image files. 

Accessing Any File Type Using a Dialog

The DIALOG_PICKFILE function lets you interactively pick a file using the 
platform’s own native graphical file selection dialog. This function returns a string or 
an array of strings that contain the full path name of the selected file or files. The user 
can also enter the name of the file. The following statement opens the selection dialog 
and shows any .pro files in the current working directory. If you select a file and 
click Open, the file variable contains the full file path. 

file = DIALOG_PICKFILE(/READ, FILTER = '*.pro')

Other keywords allow you to specify the initial directory, the dialog title, the filter 
list, and whether multiple file selection is permitted. See “DIALOG_PICKFILE” 
(IDL Reference Guide) for details.

After you select a file using DIALOG_PICKFILE, you can then use one of the file 
I/O routines to access the data within the file. See “Accessing Image Data 
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Programmatically” on page 60 or “Accessing Non-Image Data Programmatically” on 
page 64 for more information.

Importing an Image File Using a Dialog

The DIALOG_READ_IMAGE function opens a graphical user interface which lets 
you read image files. This interface simplifies the use of IDL image file I/O. You can 
preview images with a quick and simple browsing mechanism which also reports 
important information about the image file. You can also control the preview mode. 

The following statement opens the dialog so that you can select among .gif, tiff, 
.dcm, .png and .jpg files. 

result = DIALOG_READ_IMAGE(FILE=selectedFile, IMAGE=image)

See “Using the Select Image File Dialog Interface” under 
“DIALOG_READ_IMAGE” (IDL Reference Guide) for additional information if 
desired. When you select a file and click Open, the file path is stored in 
selectedFile variable and the image data is stored in the image variable. Enter 
the following line to display image data in an iImage display.

IF result EQ 1 THEN iImage, image

Saving an Image File Using a Dialog

The DIALOG_WRITE_IMAGE function displays a graphical user interface that lets 
you write and save image files. This interface simplifies the use of IDL image file 
I/O. The following statements create and write a simple image to a .tif file name 
myimage.tif:

myimage = DIST(100)
result = DIALOG_WRITE_IMAGE(myimage, FILENAME='myimage.tif') 

When you select Save, it creates a .tif file in your current working directory or the 
directory of your choice. See “DIALOG_WRITE_IMAGE” (IDL Reference Guide) 
for a complete list of keywords and a description of the dialog interface. 
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Reading ASCII Data

IDL recognizes two types of ASCII data files: free format files, and explicit format 
files. A free format file uses commas or tabs and spaces to distinguish each element 
in the file. An explicit format file distinguishes elements according to the commands 
specified in a format statement. Most ASCII files are free format files.

A Comma-Separated Values file (or CSV file) is a special type of ASCII file that uses 
the comma character to separate data files. Many spreadsheet programs can create 
CSV files to represent tabular spreadsheet data. You can use the READ_CSV routine 
to easily read this type of data, or simply select the CSV file after selecting Open 
from the IDL Workbench File menu.

Note
If you prefer not to use an interactive dialog (described below), you can also use the 
READ/READF, or READS procedures to access ASCII data. The READ procedure 
reads free format data from standard input, READF reads free format data from a 
file, and READS reads free format data from a string variable.

Launching the ASCII Template Dialog

The ASCII_TEMPLATE function launches a dialog that you can use to configure the 
structure of data in an ASCII file. Access this feature in one of the following ways: 

• From the Workbench menu — Select File → Open File  from the Workbench 
menu and select a text file

• From the Workbench Project Explorer— Double-click on a text file in the 
Project Explorer

• From an iTool — select File → Open (or click the Import File button in the 
Data Manager or Insert Visualization dialog) and select a text file 

• From the IDL command line — use the following syntax to call 
ASCII_TEMPLATE and select a text file:

sTemplate = ASCII_TEMPLATE()

Note
If you specify a Filename argument to ASCII_TEMPLATE, the dialog 
allowing you to browse to select a file will not appear. See 
“ASCII_TEMPLATE” (IDL Reference Guide) if you want specify a file and 
other parameters programmatically. 
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See “Using the ASCII Template Dialog” under “ASCII_TEMPLATE” (IDL 
Reference Guide) for instructions on how to use the dialog to define the structure of 
your ASCII data. 
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Reading Binary Data

Data is sometimes stored in files as arrays of bytes instead of a known format like 
JPEG or TIFF. These files are referred to as binary files. Binary data or binary data 
files are more compact than ASCII data files and are frequently used for large data 
files. Binary data files are stored as one long stream of bytes in a file. You will need 
to define the structure of the fields in the file in order to correctly read in the binary 
data. 

The BINARY_TEMPLATE and READ_BINARY functions are designed to define 
and access binary data. The READ_BINARY function, which reads binary data, is 
either invoked internally (when you open a binary file from the iTools), or is 
explicitly called from the command line. This function is intended to read raw binary 
data that requires no special processing (except possibly byte-order swapping). This 
function is not designed to read commercial spreadsheet or word processing files.

Note
If you prefer not to use an interactive Binary Template dialog (described below) to 
define the structure of the data in the binary file, you can use the READU 
procedure. To read binary data files, define the variables, open the file for reading, 
and read the bytes into those variables. Each variable reads as many bytes out of the 
file as required by the specified data type and organizational structure.

If you need to open a single binary file, it may be easier to use READ_BINARY to 
directly define data characteristics using keywords instead of creating a template 
using the Binary Template dialog (described below). See “READ_BINARY” (IDL 
Reference Guide) for an example. 

Launching the Binary Template Dialog

The BINARY_TEMPLATE function launches a dialog that you can use to define the 
structure of data in an binary file. Access this feature in one of the following ways: 

• From an iTool — select File → Open (or click the Import File button in the 
Data Manager or Insert Visualization dialog) and select a binary file 

• From the IDL command line — use the following syntax to call 
BINARY_TEMPLATE and select a text file:

sTemplate = BINARY_TEMPLATE()

Note
If you specify a Filename argument to BINARY_TEMPLATE, the dialog 
allowing you to browse to select a file will not appear. See 
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“BINARY_TEMPLATE” (IDL Reference Guide) if you want specify a file 
and other parameters programmatically. 

See “Using the BINARY_TEMPLATE Interface” under “BINARY_TEMPLATE” 
(IDL Reference Guide) for instructions on how to use the dialog to define the 
structure of your binary file. 
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Accessing Files Programmatically

Regardless of the data type, there are several routines that are commonly used to 
access files and data. To read data into an IDL variable, you must identify the file 
containing the data, and then extract the data from the file. This section discusses file 
access. Following sections discuss data access. 

Locating Files in the IDL Installation

Use the FILEPATH function to select a file included in the IDL distribution. For 
example, to select a file in the examples/data subdirectory of the main IDL 
installation directory, use the statement:

file = FILEPATH('mr_brain.dcm', SUBDIRECTORY=['examples', 'data'])

You can also use FILEPATH to access a file outside the IDL installation hierarchy by 
specifying the ROOT_DIR keyword. The following statement opens a file named 
testImg.tif in the C:\tempImages directory. 

file = FILEPATH('testImg.tif', ROOT_DIR='C:', $
SUBDIRECTORY='tempImages')

Locating Files Anywhere in the Filesystem

To retrieve the path to a file when you know the file’s location, use the 
FILE_SEARCH function. For example to retrieve the full path to a file named 
testFile.dat in the current directory, use the following statement:

path = FILE_SEARCH('testFile.dat', /FULLY_QUALIFY_PATH)

This technique is useful when you know the relative location of the file and need to 
know the full path.

To select a file interactively using an operating system native file selection dialog, use 
the DIALOG_PICKFILE routine. For example, to select a JPEG file from anywhere 
in the filesystem, use the following statement:

path = DIALOG_PICKFILE(TITLE='Select a JPEG file', $
FILTER = ['*.jpg', '*.jpeg'])

This displays files with the extnesion .jpg or .jpeg and returns the full path to the 
selected file.
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Accessing Image Data Programmatically

You can access image data using routines designed for general image file access, 
designed specifically for an image file format, or using unformatted data access 
routines. Which option you choose depends on the file type and the level of control 
you want over reading and writing the file. See the following topics for details:

• “Importing Formatted Image Data Programmatically” below

• “Importing Unformatted Image Files” on page 61

• “Exporting Formatted Image Files Programmatically” on page 62

• “Exporting Unformatted Image Files” on page 63

Note
These sections describe how to load data into a variable and includes examples of 
passing variable data to an iTool programmatically. See “Importing Data from the 
IDL Session” (Chapter 2, iTool User’s Guide) if you want information on how you 
can access variable data from the iTools Data Manager. 

Importing Formatted Image Data Programmatically

The majority of IDL image data access routine require a file specification, indicating 
the file from which to access the data. The FILEPATH routine is often used within a 
data access routine as shown in the following example.

Note
To validate that an image file can be accessed using READ_* routines, you can 
query the image first. See “Returning Image File Information” on page 69 for 
details. 

The following example opens a JPEG file from the examples/data directory, 
performs feature extraction, and displays both images using IIMAGE. 

; Open a file and access the data. 
file = FILEPATH('n_vasinfecta.jpg', $
   SUBDIRECTORY = ['examples', 'data'])
READ_JPEG, file, image, /GRAYSCALE

; Mask out pixel values greater than 120 
; and create a distance map.
binaryImg = image LT 120
distanceImg = MORPH_DISTANCE(binaryImg, NEIGHBOR_SAMPLING = 1)
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; Launch iImage, creating a 2 column, 1 row layout. 
; Display the original and distanceImg in the two views. 
IIMAGE, image, VIEW_GRID=[2,1]
IIMAGE, distanceImg, /VIEW_NEXT, /OVERPLOT

In the previous example, you could use the READ_IMAGE function instead of the 
READ_JPEG function by replacing the following statement:

READ_JPEG, file, image, /GRAYSCALE

with
image = READ_IMAGE(file)

In this instance, you do not have control over the color table associated with the 
image. It is often more useful to use a specific READ_* routine or object designed 
for the image file format to precisely control characteristics of the imported image. 

For a list of available image access, import and export routines and objects, see 
“Image Data Formats” under the functional category “Input/Output” (IDL Quick 
Reference). 

Note
IDL can also import images stored in scientific data formats, such as HDF and 
netCDF. For more information on these formats, see the Scientific Data Formats 
manual.

Importing Unformatted Image Files

Images in unformatted binary files can be imported with the READ_BINARY 
function using the DATA_DIMS and DATA_TYPE keywords as follows:

• You must specify the size of the image within the file using the DATA_DIMS 
keyword. This is required because the READ_BINARY function assumes the 
data values are arranged in a single vector (a one-dimensional array). The 
DATA_DIMS keyword is used to specify the size of the two- or three-
dimensional image array.

• You can set the DATA_TYPE keyword to the image’s data type using the 
associated IDL type code (see “IDL Type Codes and Names” under the SIZE 
function in the IDL Reference Guide for a complete list of type code). Most 
images in binary files are of the byte data type, which is the default setting for 
the DATA_TYPE keyword.

No standard exists by which image parameters are provided in an unformatted binary 
file. Often, these parameters are not provided at all. In this case, you should already 
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be familiar with the size and type parameters of any images you need to access within 
binary files.

For example, the worldelv.dat file is a binary file that contains an image. You can 
only import this image by supplying the information that the data values of the image 
are byte and that the image has dimensions of 360 pixels by 360 pixels. Before using 
the READ_BINARY function to access this image, you must first determine the path 
to the file:

file = FILEPATH('worldelv.dat', $
SUBDIRECTORY = ['examples', 'data'])

Define the size parameters of the image with a vector:
imageSize = [360, 360]

An image type parameter is not required because we know that the data values of 
image are byte, which is the default type for the READ_BINARY function.

The READ_BINARY function can now be used to import the image contained in the 
worldelv.dat file:

image = READ_BINARY(file, DATA_DIMS = imageSize)
IIMAGE, image

Exporting Formatted Image Files Programmatically

Images can be exported to common image file formats using the WRITE_IMAGE 
procedure. The WRITE_IMAGE procedure requires three inputs: the exported file’s 
name, the image file type, and the image itself. You can also provide the red, green, 
and blue color components to an associated color table if these components exist.

For example, you can import the image from the worldelv.dat binary file:
file = FILEPATH('worldelv.dat', $

SUBDIRECTORY = ['examples', 'data'])
imageSize = [360, 360]
image = READ_BINARY(file, DATA_DIMS = imageSize)

You can export this image to an image file (a JPEG file) with the WRITE_IMAGE 
procedure:

WRITE_IMAGE, 'worldelv.dat', 'JPEG', image

IDL also provides format-specific WRITE_* routines that are similar to the 
WRITE_IMAGE procedure, but provide more flexibility when exporting a specific 
image file type. See “Image Data Formats” under the functional category 
“Input/Output” (IDL Quick Reference) for a list of available image access, import and 
export routines and objects. 
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Note
IDL can also export images stored in scientific data formats, such as HDF and 
netCDF. For more information on these formats, see the Scientific Data Formats 
manual.

Exporting Unformatted Image Files

Images can be exported to an unformatted binary file with the WRITEU procedure. 
Before using the WRITEU procedure, you must open a file to which the data will be 
written using the OPENW procedure. Any file you open must be specifically closed 
using either the FREE_LUN or CLOSE procedure when you are done exporting the 
image.

For example, you can import the image from the rose.jpg image file:
file = FILEPATH('rose.jpg', $

SUBDIRECTORY = ['examples', 'data'])
image = READ_IMAGE(file)

You can export this image to a binary file by first opening a new file:
OPENW, unit, 'rose.dat', /GET_LUN

Then, use the WRITEU procedure to write the image to the open file:
WRITEU, unit, image

You must remember to close the file once the data has been written to it:
FREE_LUN, unit

Note
For complete details about reading, writing and formatting unformatted data, see 
Chapter 18, “Files and Input/Output” (Application Programming).
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Accessing Non-Image Data Programmatically

There are a number of options available for reading non-image data into IDL. 
Depending upon the file type, consider using one of the following:

• Formatted data — use a data-type-specific routine (such as READ_ASCII or 
READ_BINARY). See “Reading Binary Data in a Volume” below for more 
information.

• Unformatted data — use a general data access routines (such as OPEN or 
WRITE). For complete details about reading, writing and formatting 
unformatted data, see Chapter 18, “Files and Input/Output” (Application 
Programming).

• SAVE file data — use the RESTORE procedure to access variable data in a 
SAVE file. See “Reading Contour Data from a SAVE File” on page 65 for an 
example.

Note
These sections describe how to load data into a variable and includes examples of 
passing variable data to an iTool programmatically. See “Importing Data from the 
IDL Session” (Chapter 2, iTool User’s Guide) if you want information on how you 
can access variable data from the iTools Data Manager. 

Reading Binary Data in a Volume

The following example uses READ_BINARY to access binary data (head.dat) 
consisting of a stack of 57 images slices of the human head. After reading the data, 
create a display using IVOLUME. Enter the following at the IDL command prompt:

file = FILEPATH('head.dat', $
SUBDIRECTORY = ['examples', 'data'])

dataSize = [80,100,57]
volume= READ_BINARY(file, DATA_DIMS = dataSize)
iVolume, volume, /AUTO_RENDER

Note
You can also create a template for binary file access. See “Reading Binary Data” on 
page 57 for options. 
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Reading Contour Data from a SAVE File

You can also access information from a SAVE file. This example restores a SAVE file 
containing variable data (marbells.dat), configures the data, and displays it using 
ICONTOUR.

PRO maroonBellsContour_doc

; Restore Maroon Bells data into the IDL variable "elev". 
RESTORE, FILEPATH('marbells.dat', SUBDIR=['examples','data'])

; Create x and y vectors giving the position of each 
; column and row.
X = 326.850 + .030 * FINDGEN(72)
Y = 4318.500 + .030 * FINDGEN(92)

; Set missing data points to a large value. Reduce to a
; 72 x 92 matrix. 
elev (WHERE (elev EQ 0)) = 1E6 
new = REBIN(elev, 360/5, 460/5) 

iContour, new, X, Y, C_VALUE = 2750 + FINDGEN(6) * 250.,$
 XSTYLE = 1, YSTYLE = 1, YMARGIN = 5, MAX_VALUE = 5000, $ 
   C_LINESTYLE = [1, 0], $ 
   C_THICK = [1, 1, 1, 1, 1, 3], $ 
   XTITLE = 'UTM Coordinates (KM)'
   
End 

Note
See Chapter 4, “Creating SAVE Files of Programs and Data” (Application 
Programming) for complete details on creating and restoring SAVE files. 
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File Access Routines 

See the following categories under “Input/Output” (IDL Quick Reference) for a list of 
available file and data access routines: 

• “Image Data Formats” — includes read and write routines for supported image 
formats (such as JPEG, TIFF, DICOM, etc.), and routines that launch dialogs 
for image file access.

• “Scientific Data Formats” — includes CDF, EOS, NCDF, HDF, and HDF5 
routines.

• “Other Data Formats” — includes routines that access ASCII, BINARY, XML, 
and other non-image data formats.

• “General Input/Output” — includes READ, WRITE and other routines 
commonly used when accessing unformatted data. Also see Chapter 18, “Files 
and Input/Output” for information on using these routines and formatting your 
data. 
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Investigating Files and Data

There are a number of routines and functions in IDL that allow you to quickly access 
information about your data. While it is always a good idea to know your data before 
processing, the routines in this chapter can help you uncover details of arrays, 
expressions, SAVE files, objects, or specific images. 

Accessing Information in iTools

When you are working in the iTools, there are a number of ways to get information 
about variable data, an object’s properties, an image’s statistical information, and the 
data hierarchy. For more information about these options, see the following topics: 

• “About the Data Manager” (Chapter 2, iTool User’s Guide) provides 
information on data associated with a visualization

• “The iTool Visualization Browser” (Chapter 6, iTool User’s Guide) provides 
information on the properties of a visualization

• “Additional Operations” (Chapter 7, iTool User’s Guide) describes the 
Histogram and Statistics windows available in iTools 
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Returning Image File Information 

When accessing formatted image data (not contained in a binary file), there are a 
number of ways to get information about the data characteristics. The most flexible is 
the QUERY_IMAGE routine, which returns a structure that includes the number of 
image channels, pixel data type and palette information. If you need specific 
information from a formatted image file, you can use the QUERY* routine 
specifically designed for images of that format. 

Note
You can also use the SIZE function to quickly return the size of an image array. See 
“Using SIZE to Return Image Dimensions” on page 75 for details. 

Using the QUERY_IMAGE Info Structure

Common image file formats contain standardized header information that can be 
queried. IDL provides the QUERY_IMAGE function to return valuable information 
about images stored in supported image file formats.

For example, using the QUERY_IMAGE function, you can return information about 
the mineral.png file in the examples/data directory. First, access the file. Then 
use the QUERY_IMAGE function to return information about the file:

file = FILEPATH('mineral.png', $
SUBDIRECTORY = ['examples', 'data'])

queryStatus = QUERY_IMAGE(file, info)

To determine the success of the QUERY_IMAGE function, print the value of the 
query variable:

PRINT, 'Status = ', queryStatus

IDL prints
queryStatus = 1

If queryStatus is zero, the file cannot be accessed with IDL. If queryStatus is one, the 
file can be accessed. Because the query was successful, the info variable is now an 
IDL structure containing image parameters. The tags associated with this structure 
variable are standard across image files. You can view the tags of this structure by 
setting the STRUCTURE keyword to the HELP command with the info variable as 
its argument:

HELP, info, /STRUCTURE
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IDL displays the following text in the Output Log:
** Structure <1407e70>, 7 tags, length=36, refs=1:
   CHANNELS LONG 1
   DIMENSIONS LONG Array[2]
   HAS_PALETTE INT 1
   IMAGE_INDEX LONG 0
   NUM_IMAGES LONG 1
   PIXEL_TYPE INT 1
   TYPE STRING 'PNG'

The structure tags provide the following information:

Tag Description

CHANNELS Provides the number of dimensions within the image array:
• 1 – two-dimensional array
• 3 – three-dimensional array

Print the number of dimensions using:
PRINT, 'Number of Channels: ', info.channels

For the mineral.png file, IDL prints:
Number of Channels:           1

DIMENSIONS Contains image array information including the width and 
height. Print the image dimensions using:
PRINT, 'Size: ', info.dimensions

For the mineral.png file, IDL prints:
Size:           288         216

HAS_PALETTE Describes the presence or absence of a color palette:
• 1 (True) – the image has an associated palette
• 0 (False) – the image does not have an associated palette

Print whether a palette is present or not using:
PRINT, 'Is Palette Available?: ', info.has_palette

For the mineral.png file, IDL prints:
Is Palette Available?:           1

Table 4-1: Image Structure Tag Information
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IMAGE_INDEX Gives the zero-based index number of the current image. Print 
the index of the image using:
PRINT, 'Image Index: ', info.image_index

For the mineral.png file, IDL prints:
Image Index:           0

NUM_IMAGES Provides the number of images in the file. Print the number of 
images in the file using:
PRINT, 'Number of Images: ', info.num_images

For the mineral.png file, IDL prints:
Number of Images:           1

Tag Description

Table 4-1: Image Structure Tag Information (Continued)
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From the contents of the info variable, it can be determined that the single image 
within the mineral.png file is an indexed image because it has only one channel (is 
a two-dimensional array) and it has a color palette. The image also has byte pixel 
data. 

PIXEL_TYPE Provides the IDL type code for the image pixel data type:
• 0 – Undefined
• 1 – Byte
• 2 – Integer
• 3 – Longword integer
• 4 – Floating point
• 5 – Double-precision floating
• 6 – Complex floating
• 9 – Double-precision complex
• 12 – Unsigned Integer
• 13 – Unsigned Longword Integer
• 14 – 64-bit Integer
• 15 – Unsigned 64-bit Integer

See “IDL Type Codes and Names” under the SIZE function in 
the IDL Reference Guide for a complete list of type codes.
Print the data type of the pixels in the image using:
PRINT, 'Data Type: ', info.pixel_type

For the mineral.png file, IDL displays the following text in 
the Output Log:
Data Type:           1

TYPE Identifies the image file format. Print the format of the file 
containing the image using:
PRINT, 'File Type: ' + info.type

For the mineral.png file, IDL prints:
File Type: PNG

Tag Description

Table 4-1: Image Structure Tag Information (Continued)
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Note
When working with RBG images (with a CHANNELS value of 3) it is important to 
determine the interleaving (the arrangement of the red, green, and blue channels of 
data) in order to properly display these image. See “RGB Image Interleaving” 
(Chapter 5, Using IDL) for an example that shows you how to determine the 
arrangement of these channels. 

Using Specific QUERY_* Routines 

All of the QUERY_* routines return a status, which determines if the file can be read 
using the corresponding READ_ routine. All of these routines also return the Info 
structure, (described in the previous section), which reports image dimensions, 
number of samples per pixel, pixel type, palette info, and the number of images in the 
file. However, some of the QUERY_* routines (such as QUERY_MRSID and 
QUERY_TIFF) return more detailed information particular to that specific image 
format. See “Query Routines” (IDL Quick Reference) for a complete list of the 
available QUERY_* routines. 
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Returning Type and Size Information
The SIZE function returns size and type information for a given expression. The 
returned vector is always of longword type. 

• The first element is equal to the number of dimensions of the parameter and is 
zero if the parameter is a scalar.

• The next elements contain the size of each dimension.

• After the dimension sizes, the last two elements indicate the data type and the 
total number of elements, respectively. 

See “IDL Type Codes and Names” under the SIZE function in the IDL Reference 
Guide for a complete list of type codes. See the following examples for more 
information on the SIZE function:

• “Determining if a Variable is a Scalar or an Array” below

• “Using SIZE to Return Image Dimensions” on page 75

In addition to the examples listed above, also see the following SIZE function 
examples in the IDL Reference Guide:

• “Example: Returning Array Dimension Information”

• “Example: Returning the IDL Type Code of an Expression”

Determining if a Variable is a Scalar or an Array
The SIZE function can be used to determine whether a variable holds a scalar value 
or an array. Setting the DIMENSIONS keyword causes the SIZE function to return a 
0 if the variable is a scalar, or the dimensions if the variable is an array:

A = 1
B = [1]
C = [1,2,3]
D = [[1,2],[3,4]]

PRINT, SIZE(A, /DIMENSIONS)
PRINT, SIZE(B, /DIMENSIONS)
PRINT, SIZE(C, /DIMENSIONS)
PRINT, SIZE(D, /DIMENSIONS)

IDL Prints:
0
1
3
2 2
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Using SIZE to Return Image Dimensions

The following example reads an image array and uses the SIZE function 
DIMENSIONS keyword to access the number of rows and columns in the image file. 
In this simple example, the information is used to create a display window of the 
correct size. 

PRO ex_displayImage

; Select and read the image file.
earth = READ_PNG (FILEPATH ('avhrr.png', $

SUBDIRECTORY = ['examples', 'data']), R, G, B)

; Load the color table and designate white to occupy the
; final position in the red, green and blue bands.
TVLCT, R, G, B
maxColor = !D.TABLE_SIZE - 1
TVLCT, 255, 255, 255, maxColor

; Prepare the display device.
DEVICE, DECOMPOSED = 0, RETAIN = 2

; Get the size of the original image array.
earthSize = SIZE(earth, /DIMENSIONS)

; Prepare a window and display the new image.
WINDOW, 0, XSIZE = earthSize[0], YSIZE = earthSize[1]
TV, earth

END
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Getting Information About SAVE Files

The IDL_Savefile object provides an object-oriented interface that allows you to 
query a SAVE file for information and restore one or more individual items from the 
file. Using IDL_Savefile, you can retrieve information about the user, machine, and 
system that created the SAVE file, as well as the number and size of the various items 
contained in the file (variables, common blocks, routines, etc). Individual items can 
be selectively restored from the SAVE file.

Use IDL_Savefile in preference to the RESTORE procedure when you need to obtain 
detailed information on the items contained within a SAVE file without first restoring 
it, or when you wish to restore only selected items. Use RESTORE when you want to 
restore everything from the SAVE file using a simple interface.

Note
The IDL_Savefile object does not provide methods that allow you to modify an 
existing SAVE file. The only way to modify an existing SAVE file is to restore its 
contents into a fresh IDL session, modify the contained routines or variables as 
necessary, and use the SAVE procedure to create a new version of the file.

To use the IDL_Savefile object to restore items from an existing SAVE file, do the 
following:

• Create a Savefile Object

• Query the Savefile Object

• Restore Items from the Savefile Object

• Destroy the Savefile Object

The following sections describe each of these steps. For complete information on the 
IDL_Savefile object and its methods, see “IDL_Savefile” (Chapter 34, IDL Reference 
Guide).

Create a Savefile Object

When an IDL_Savefile object is instantiated, it opens the actual SAVE file for 
reading and creates an in-memory representation of its contents — without actually 
restoring the file. The savefile object persists until it is explicitly destroyed (or until 
the IDL session ends); the SAVE file itself is held open for reading as long as the 
savefile object exists.
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To create a savefile object from the draw_arrow.sav file created in “Example: A 
SAVE File of a Simple Routine” (Chapter 4, Application Programming), use the 
following command:

myRoutines = OBJ_NEW('IDL_Savefile', 'draw_arrow.sav')

Similarly, to create a savefile object from the saved image data, use the following 
command:

myImage = OBJ_NEW('IDL_Savefile', 'imagefile.sav')

Query the Savefile Object

Once you have created a savefile object, three methods allow you to retrieve 
information about its contents:

• The Contents method provides information about the SAVE file including the 
number and type of items contained therein. 

• The Names method allows you to retrieve the names of routines and variables 
stored in the file. 

• The Size method allows you to retrieve size and type information about the 
variables stored in the file.

Contents Method

The Contents method returns a structure variable that describes the SAVE file and its 
contents. The individual fields in the returned structure are described in detail in 
“IDL_Savefile::Contents” (Chapter 34, IDL Reference Guide).

In addition to providing information about the system that created the SAVE file, the 
Contents method allows you to determine the number of each type of saved item 
(variable, procedure, function, etc.) in the file. This information can be used to 
programmatically restore items from the SAVE file.

Assuming you have created the myRoutines savefile object, the data returned by the 
Contents method looks like this:

savefileInfo = myRoutines->Contents()
HELP, savefileInfo, /STRUCTURE

IDL Prints:
** Structure IDL_SAVEFILE_CONTENTS, 17 tags, length=176, data leng
th=172:

FILENAME STRING    '/itt/test/draw_arrow.sav'
DESCRIPTION STRING    ''
FILETYPE STRING    'Portable (XDR)'
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USER STRING    'dquixote'
HOST STRING    'DULCINEA'
DATE STRING    'Thu May 08 12:04:46 2003'
ARCH STRING    'x86'
OS STRING    'Win32'
RELEASE STRING    '7.1'
N_COMMON LONG64                         0
N_VAR LONG64                         0
N_SYSVAR LONG64                         0
N_PROCEDURE LONG64                         2
N_FUNCTION LONG64                         0
N_OBJECT_HEAPVAR LONG64                         0
N_POINTER_HEAPVAR LONG64                         0
N_STRUCTDEF LONG64                         0

From this you can determine the name of the SAVE file from which the information 
was extracted, the names of the user and computer who created the file, the creation 
date, and information about the IDL system that created the file. You can also see that 
the SAVE file contains definitions for two procedures and nothing else.

Names Method

The Names method returns a string array containing the names of the variables, 
procedures, functions, or other items contained in the SAVE file. By default, the 
method returns the names of variables; keywords allow you to specify that names of 
other items should be retrieved. The available keyword options are described in 
“IDL_Savefile::Names” (Chapter 34, IDL Reference Guide).

The names of items retrieved using the Names method can be supplied to the Size 
method to retrieve size and type information about the specific items, or to the 
Restore method to restore individual items.

For example, calling the Names method with the PROCEDURE keyword on the 
myRoutines savefile object yields the names of the two procedures saved in the file:

PRINT, myRoutines->Names(/PROCEDURE)

IDL Prints:
ARROW DRAW_ARROW

Similarly, to retrieve the name of the variable saved in imagefile.sav, which is 
referred to by the myImage savefile object:

PRINT, myImage->Names()

IDL Prints:
IMAGE
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Size Method

The Size method returns the same information about a variable stored in a SAVE file 
as the SIZE function does about a regular IDL variable. It accepts the same keywords 
as the SIZE function, and returns the same information using the same formats. The 
Size method differs only in that the argument is a string or integer identifier string 
(returned by the Names method) that specifies an item within a SAVE file, rather than 
an in-memory expression. See “IDL_Savefile::Size” (Chapter 34, IDL Reference 
Guide) for additional details.

For example, to determine the dimensions of the image stored in the 
imagefile.sav file, do the following:

imagesize = myImage->Size('image', /DIMENSIONS)
PRINT, 'Image X size:', imagesize[0]
PRINT, 'Image Y size:', imagesize[1]

IDL Prints:
Image X size:         256
Image Y size:         256

Restore Items from the Savefile Object

The Restore method allows you to selectively restore one or more items from the 
SAVE file associated with a savefile object. Items to be restored are specified using 
the item name strings returned by the Names method. In addition to functions, 
procedures, and variables, you can also restore COMMON block definitions, 
structure definitions, and heap variables. See “IDL_Savefile::Restore” (Chapter 34, 
IDL Reference Guide) for additional details.

For example, to restore the DRAW_ARROW procedure without restoring the 
ARROW procedure, do the following:

myRoutines->Restore, 'draw_arrow'

Note on Restoring Objects and Pointers

Object references and pointers rely on special IDL variables called heap variables. 
When you restore a regular IDL variable that contains an object reference or a 
pointer, the associated heap variable is restored automatically; there is no need to 
restore the heap variables separately. It is, however, possible to restore the heap 
variables independently of any regular IDL variables; see “Restoring Heap Variables 
Directly” (Chapter 34, IDL Reference Guide) for complete details.
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Destroy the Savefile Object

To destroy a savefile object, use the OBJ_DESTROY procedure:
OBJ_DESTROY, myRoutines
OBJ_DESTROY, myImage

Destroying the savefile object will close the SAVE file with which the object is 
associated.
Getting Information About SAVE Files Using IDL



Chapter 4: Getting Information About Files and Data 81
Returning Object Type and Validity

Three IDL routines allow you to obtain information about an existing object: 
OBJ_CLASS, OBJ_ISA, and OBJ_VALID. 

OBJ_CLASS

Use the OBJ_CLASS function to obtain the class name of a specified object, or to 
obtain the names of a specified object’s direct superclasses. For example, if we create 
the following class structures:

struct = {class1, data1:0.0 }
struct = {class2, data2a:0, data2b:0L, INHERITS class1 }

We can now create an object and use OBJ_CLASS to determine its class and 
superclass membership.

; Create an object.
A = OBJ_NEW('class2')

; Print A’s class membership.
PRINT, OBJ_CLASS(A)

IDL prints:
CLASS2

Or you can print as superclasses:
; Print A’s superclasses.
PRINT, OBJ_CLASS(A, /SUPERCLASS)

IDL prints:
CLASS1

See “OBJ_CLASS” (IDL Reference Guide) for further details.

OBJ_ISA

Use the OBJ_ISA function to determine whether a specified object is an instance or 
subclass of a specified object. For example, if we have defined the object A as above:

IF OBJ_ISA(A, 'class2') THEN $
PRINT, 'A is an instance of class2.'

IDL prints:
A is an instance of class2.

See “OBJ_ISA” (IDL Reference Guide) for further details.
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OBJ_VALID

Use the OBJ_VALID function to verify that one or more object references refer to 
valid and currently existing object heap variables. If supplied with a single object 
reference as its argument, OBJ_VALID returns TRUE (1) if the reference refers to a 
valid object heap variable, or FALSE (0) otherwise. If supplied with an array of 
object references, OBJ_VALID returns an array of TRUE and FALSE values 
corresponding to the input array. For example:

; Create a class structure.
struct = {cname, data:0.0}

; Create a new object.
A = OBJ_NEW('CNAME')

IF OBJ_VALID(A) PRINT, "A refers to a valid object." $
ELSE PRINT, "A does not refer to a valid object."

IDL prints:
A refers to a valid object.

If we destroy the object:
; Destroy the object.
OBJ_DESTROY, A

IF OBJ_VALID(A) PRINT, "A refers to a valid object." $
ELSE PRINT, "A does not refer to a valid object."

IDL prints:
A does not refer to a valid object.

See “OBJ_VALID” (IDL Reference Guide) for further details.
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Returning Information About a File

You can use the FILE_INFO function to retrieve information about a file that is not 
currently open. To get information about an open file (for which there is an IDL 
Logical Unit Number), use the HELP procedure or the FSTAT function. See 
“Returning Information About a File Unit” (Chapter 18, Application Programming). 

The FILE_INFO function returns a structure expression of type FILE_INFO 
containing information about the file. For example, get information on dist.pro: 

HELP,/STRUCTURE, FILE_INFO(FILEPATH('dist.pro', 
SUBDIRECTORY='lib')) 

The above command will produce output similar to: 
** Structure FILE_INFO, 21 tags, length=72:
        NAME            STRING  '/usr/local/itt/idl/lib/dist.pro'
        EXISTS          BYTE         1
        READ            BYTE         1
        WRITE           BYTE         0
        EXECUTE         BYTE         0
        REGULAR         BYTE         1
        DIRECTORY       BYTE         0
        BLOCK_SPECIAL   BYTE         0
        CHARACTER_SPECIAL
                        BYTE         0
        NAMED_PIPE      BYTE         0
        SETGID          BYTE         0
        SETUID          BYTE         0
        SOCKET          BYTE         0
        STICKY_BIT      BYTE         0
        SYMLINK         BYTE         0
        DANGLING_SYMLINK
                        BYTE         0
        MODE            LONG               420
        ATIME           LONG64                 970241431
        CTIME           LONG64                 970241595
        MTIME           LONG64                 969980845
        SIZE            LONG64                      1717

The fields of the FILE_INFO structure provide various information about the file, 
such as the size of the file, and the dates of last access, creation, and last 
modification. For more information on the fields of the FILE_INFO structure, see 
“FILE_INFO” (IDL Reference Guide). See “FILE_LINES” (IDL Reference Guide) 
for information on how to retrieve the number of lines of text in a file.
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IDL Visual Display Systems

When creating visualizations in IDL, you can choose to create a visualization in an 
IDL Intelligent Tool (iTool), in an Object Graphics display, or in a Direct Graphics 
display:

• iTools — introduced in IDL 6.0, the IDL Intelligent Tools (iTools) provide the 
power and flexibility of Object Graphics with a pre-built visualization system 
that offers a great deal of interactivity. This set of interactive utilities combine 
data analysis and visualization with the task of producing presentation quality 
graphics. See “iTools Visualizations” below for more information. 

• Object Graphics — introduced in IDL 5.0, Object Graphics use an object-
oriented programmers’ interface to create graphic objects, which must then be 
drawn, explicitly, to a destination of the programmer’s choosing. See “IDL 
Object Graphics” on page 87 for more information.

• Direct Graphics — the oldest visualization system of the three, Direct 
Graphics rely on the concept of a current graphics device to quickly create 
simple static visualizations using IDL commands like PLOT or SURFACE. 
See “IDL Direct Graphics” on page 88 for information.

This chapter introduces the IDL display systems and provides information on 
common topics shared by the systems. Topics include a discussion on coordinates, 
coordinate conversion, interpolation, color systems and color schemes, and fonts. 

iTools Visualizations

The new IDL Intelligent Tools (iTools) are a set of interactive utilities that combine 
data analysis and visualization with the task of producing presentation quality 
graphics. Based on the IDL Object Graphics system, the iTools are designed to help 
you get the most out of your data with minimal effort. They allow you to continue to 
benefit from the control of a programming language, while enjoying the convenience 
of a point-and-click environment.

The main enhancements the new iTools provide are more mouse interactivity, 
WYSIWYG (What-You-See-Is-What-You-Get) printing, built-in analysis, undo-redo 
capabilities, layout control, and better-looking plots. These robust, pre-built tools 
reduce the amount of programming IDL users must do to create interactive 
visualizations. At the same time, the iTools integrate in a seamless manner with the 
IDL Command Line, user interface controls, and custom algorithms. In this way, the 
iTools maintain and enhance the control and flexibility IDL users rely on for data 
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exploration, algorithm design, and rapid application development. The following 
manuals provide more information:

• iTool User’s Guide — describes how to create visualization using iTools

• iTool Programming — describes how to create and customize an iTool

IDL Object Graphics

The salient features of Object Graphics are:

• Object graphics are device independent. There is no concept of a current 
graphics device when using object-mode graphics; any graphics object can be 
displayed on any physical device for which a destination object can be created.

• Object graphics are object-oriented. Graphic objects are meant to be created 
and re-used; you may create a set of graphic objects, modify their attributes, 
draw them to a window on your computer screen, modify their attributes again, 
then draw them to a printer device without reissuing all of the IDL commands 
used to create the objects. Graphics objects also encapsulate functionality; this 
means that individual objects include method routines that provide 
functionality specific to the individual object.

• Object graphics are rendered in three dimensions. Rendering implies many 
operations not needed when drawing Direct Graphics, including calculation of 
normal vectors for lines and surfaces, lighting considerations, and general 
object overhead. As a result, the time needed to render a given object—a 
surface, say—will often be longer than the time taken to draw the analogous 
image in Direct Graphics. 

• Object Graphics use a programmer’s interface. Unlike Direct Graphics, which 
are well suited for both programming and interactive, ad hoc use, Object 
Graphics are designed to be used in programs that are compiled and run. While 
it is still possible to create and use graphics objects directly from the IDL 
command line, the syntax and naming conventions make it more convenient to 
build a program offline than to create graphics objects on the fly.

• Because Object Graphics persist in memory, there is a greater need for the 
programmer to be cognizant of memory issues and memory leakage. Efficient 
design—remembering to destroy unused object references and cleaning up—
will avert most problems, but even the best designs can be memory-intensive if 
large numbers of graphic objects (or large datasets) are involved.
Using IDL IDL Visual Display Systems



88 Chapter 5: Graphic Display Essentials
For more information on creating Object Graphic visualizations see: 

• Object Programming — this manual introduces using IDL objects and also 
describes how to create custom objects in IDL.

• “Object Class and Method Reference” (IDL Reference Guide) — this section 
in the IDL Reference Guide provides complete reference material describing 
IDL’s object classes

• iTool User’s Guide and iTool Programming — these manuals provide 
complete details about using and creating object-based iTool displays

IDL Direct Graphics

IDL Direct Graphics is the original graphics rendering system introduced in IDL. 
Graphic displays creating using Direct Graphics are static — once created, no 
changes can be made without recreating the visualization being displayed. If you 
have used routines such as PLOT or SURFACE, you are already familiar with this 
graphics system. The salient features of Direct Graphics are:

• Direct Graphics use a graphics device (X for X-windows systems displays, 
WIN for Microsoft Windows displays, PS for PostScript files, etc.). You 
switch between graphics devices using the SET_PLOT command, and control 
the features of the current graphics device using the DEVICE command.

• IDL commands that existed in IDL 4.0 use Direct Graphics. Commands like 
PLOT, SURFACE, XYOUTS, MAP_SET, etc. all draw their output directly 
on the current graphics device.

• Once a direct-mode graphic is drawn to the graphics device, it cannot be 
altered or re-used. This means that if you wish to re-create the graphic on a 
different device, you must re-issue the IDL commands to create the graphic.

• When you add a new item to an existing direct-mode graphic (using a routine 
like OPLOT or XYOUTS), the new item is drawn in front of the existing 
items.

See “Direct Graphics” (IDL Quick Reference) for a list of available routines. 
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IDL Coordinate Systems 

You can specify coordinates to IDL in one of the following coordinate systems:

DATA Coordinates

This coordinate system is established by the most recent PLOT, CONTOUR, or 
SURFACE procedure. This system usually spans the plot window, the area bounded 
by the plot axes, with a range identical to the range of the plotted data. The system 
can have two or three dimensions and can be linear, logarithmic, or semi-logarithmic. 
The mechanisms of converting from one coordinate system to another are described 
below. 

DEVICE Coordinates

This coordinate system is the physical coordinate system of the selected plotting 
device. Device coordinates are integers, ranging from (0, 0) at the bottom-left corner 
to (Vx –1, Vy –1) at the upper-right corner. Vx and Vy are the number of columns and 
rows addressed by the device. These numbers are stored in the system variable !D as 
!D.X_SIZE and !D.Y_SIZE. In a widget base, device coordinates are measures from 
the upper-left corner

NORMAL Coordinates

The normalized coordinate system ranges from zero (0) to one (1) over each of the 
three axes.

Almost all of the IDL graphics procedures accept parameters in any of these 
coordinate systems. Most procedures use the data coordinate system by default. 
Routines beginning with the letters TV are notable exceptions. They use device 
coordinates by default. You can explicitly specify the coordinate system to be used 
by including one of the keyword parameters /DATA, /DEVICE, or /NORMAL in the 
call. 

Understanding Windows and Related Device 
Coordinates

Images are displayed within a window (Direct Graphics) or within an instance of a 
window object (Object Graphics). In Direct Graphics, the WINDOW procedure is 
used to initialize the coordinates system for the image display. In Object Graphics, 
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the IDLgrWindow, IDLgrView, and IDLgrModel objects are used to initialize the 
coordinate system for the image display.

A coordinate system determines how and where the image appears within the 
window. You can specify coordinates to IDL using one of the following coordinate 
systems:

• Data Coordinates — This system usually spans the window with a range 
identical to the range of the data. The system can have two or three dimensions 
and can be linear, logarithmic, or semi-logarithmic.

• Device Coordinates — This coordinate system is the physical coordinate 
system of the selected device. Device coordinates are integers, ranging from 
(0, 0) at the bottom-left corner to (Vx –1, Vy –1) at the upper-right corner of the 
display. Vx and Vy are the number of columns and rows of the device (a display 
window for example).

Note
For images, the data coordinates are the same as the device coordinates. The 
device coordinates of an image are directly related to the pixel locations 
within an image. Unless otherwise specified, IDL draws each image pixel per 
each device pixel.

• Normal Coordinates — The normalized coordinate system ranges from zero to 
one over columns and rows of the device.
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Coordinates of 3-D Graphics

Points in xyz space are expressed by vectors of homogeneous coordinates. These 
vectors are translated, rotated, scaled, and projected onto the two-dimensional 
drawing surface by multiplying them by transformation matrices. The geometrical 
transformations used by IDL, and many other graphics packages, are taken from 
Chapters 7 and 8 of Foley and Van Dam (Foley, J.D., and A. Van Dam (1982), 
Fundamentals of Interactive Computer Graphics, Addison-Wesley Publishing Co.). 
The reader is urged to consult this book for a detailed description of homogeneous 
coordinates and transformation matrices since this section presents only an overview. 
Three-dimensional graphics, coordinate systems, and transformations also are 
included in this chapter.

Homogeneous Coordinates

A point in homogeneous coordinates is represented as a four-element column vector 
of three coordinates and a scale factor w ¼¼≠ 0. For example:

P(wx, wy, wz, w) ≡ P(x/w, y/w, z/w, 1) ≡ (x, y, z)

One advantage of this approach is that translation, which normally must be expressed 
as an addition, can be represented as a matrix multiplication. Another advantage is 
that homogeneous coordinate representations simplify perspective transformations. 
The notion of rows and columns used by IDL is opposite that of Foley and Van Dam 
(1982). In IDL, the column subscript is first, while in Foley and Van Dam (1982) the 
row subscript is first. This changes all row vectors to column vectors and transposes 
matrices.

Right-Handed Coordinate System

The coordinate system is right-handed so that when looking from a positive axis to 
the origin, a positive rotation is counterclockwise. As usual, the x-axis runs across the 
display, the y-axis is vertical, and the positive z-axis extends out from the display to 
the viewer. For example, a 90-degree positive rotation about the z-axis transforms the 
x-axis to the y-axis.

Transformation Matrices

Transformation matrices, which post-multiply a point vector to produce a new point 
vector, must be (4, 4). A series of transformation matrices can be concatenated into a 
single matrix by multiplication. If A1, A2, and A3 are transformation matrices to be 
Using IDL Coordinates of 3-D Graphics



92 Chapter 5: Graphic Display Essentials
applied in order, and the matrix A is the product of the three matrices, the following 
applies.

((P • A1) • A2) • A3 ≡ P • ((A1 • A2) • A3) = P • A

In Object Graphics, IDL the model object that contains the displayed object stores the 
transformation matrix. In Direct Graphics, IDL stores the concatenated 
transformation matrix in the system variable field !P.T. 

Note
When displaying objects in a three-dimensional view, you can precisely configure 
the object position using transformation matrices. See “Translating, Rotating and 
Scaling Objects” (Chapter 3, Object Programming) for details. 

Note
For most Direct Graphic applications, it is not necessary to create, manipulate, or to 
even understand transformation matrices. See the T3D procedure, which 
implements most of the common transformations.

Each of the operations of translation, scaling, rotation, and shearing can be 
represented by a transformation matrix.

Translation

The transformation matrix to translate a point by (Dx, Dy, Dz) is shown below.

 

Scaling

Scaling by factors of Sx, Sy, and Sz about the x-, y-, and z-axes respectively, is 
represented by the matrix below.
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